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VOLUME-T
Chapter-1
INTRODUCTION TO COMPUTERS

Jmportant 2 & 3 Margs

1. What is Computer?
It is an electronic device that processes the input according to the set of instructions provided to it and

gives the desired output at a very fast rate.
2. Give Short note on: First Digital Computer or Write a note on ENIAC Computer

The ENIAC (Electronic Numerical Integrator And Calculator) was invented by J. Presper Eckert and
John Mauchly at the University of Pennsylvania and began construction in 1943 and was not completed
until 1946. It occupied about 1,800 square feet and used about 18,000 vacuum tubes, weighing almost 50
tons. ENIAC was the first digital computer because it was fully functional.
3. What is NLP?

Natural Language Processing (NLP) is a component of Artificial Intelligence (Al). It provides the ability

to develop the computer program to understand human language.
4. What is DLNN?

Optical Character Recognition (Optical Grapheme Recognition) engine for the Indus Scripts has been
developed using Deep Learning Neural Networks (a sub-field of Artificial Intelligence).
5. What is Data and Information?

Data: Data is defined as an un- processed collection of raw facts
Information : Data is the raw facts that is processed to give meaningful messages.
6. What is Booting?

When a computer is switched on, there is no information in its RAM.At the same time, in ROM,
the pre-written program called POST (Power on Self Test) will be executed first. This program checks if the
devices like RAM, keyboard, etc., are connected properly and ready to operate. If these devices are ready,
then the BIOS (Basic Input Output System) gets executed. This process is called Booting.

6. What is Bootstrap?
“Bootstrap Loader” transfers OS from hard disk into main memory.

7. What is GUI?

Modern operating systems use a Graphical User Interface(GUI). A GUI lets you use your mouse to
click icons, buttons, menus and everything is clearly displayed on the screen using a combination of
graphics and text elements. 1
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8. What is IPO Cycle?
Every task given to a computer follows an Input- Process- Output Cycle (IPO cycle). It needs certain
input, processes that input and produces the desired output.
9. What is OCR?
Optical Character Reader: It is a device which detects characters printed or written on a paper with
OCR, a user can scan a page from a book. The Computer will recognize the characters in the page as letters
and punctuation marks and stores. The Scanned document can be edited using a wordprocessor

10. What is Keyer?

A Keyer is a device for signaling by hand, by way of pressing one or more switches.

Jmportant 5 Margs

1. Explain about Generations of Computer.

S.No | Generation Period Main component Type used
Used
1 First 1942-1955 Vaccum Tubes ENIAC, EDVAC, UNIVAC
1
2 Second 1955-1964 Transistors IBM1401, 1620,
UNIVAC 1108
3 Third 1964-1975 Integrated Circuit-IC | 1BM 360 Series, Honey well
series
4 Fourth 1975-1980 Microprocessor-VLSI- -
Very Large Scale
Integrated Circuit
5 Fifth 1980-till date ULSI - Ultra Large -
Scale Integration
6 Sixth In future - -

2. What are the components of computer?
1. Inputunit

2. Central Processing Unit

3. Arithmetic and Logic Unit
4. Control Unit

5. Output Unit

6. Memory Unit
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3. What are Input Devices & Output Devices?

Input Devices

Output Devices

1. Keyboard- Most Commonly used Input Device
2. Mouse
Types of Mouse:
1. Mechanical Mouse
2. Optical Mouse
3. Laser Mouse
. Scanner
. Finger Print Scanner
. Track Ball
. Retinal Scanner
. Light Pen
. Optical Character Reader
. Bar Code / QR Code Reader
10. Voice Input Systems

© 00 N O U b~ W

11. Digital Camera
12. Touch Screen
13. Keyer

1. Monitor -Most Commonly used Output Device
2. Plotter
3. Printer
Types of Printer:
1. Impact Printer
Dot Matrix & Line Printer
2. Non-Impact Printer
Laser & Inkjet
4. Speaker

5. Multimedia Projectors

4. What are the types of booting?

1. Cold Booting: When the system starts from initial state i.e. it is switched on, we call it cold

booting or Hard Booting. When the user presses the Power button, the instructions are read from the

ROM to initiate the booting process.

2. Warm Booting: When the system restarts or when Reset button is pressed, we call it Warm

Booting or Soft Booting. The system does not start from initial state and so all diagnostic tests need not

be carried out in this case. There are chances of data loss and system damage as the data might not have

been stored properly.
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Chapter-2

Number Systems
Jmportant 2 & 3 Margs

1. What is Machine Language?

‘0’ and ‘1’ that the Computer can understand is called Machine language.
2. What is BIT?
A bit is the short form of Binary digit which can be ‘0’ or ‘1°. It is the basic unit of data in computers.
3. What is Nibble?
A nibble is a collection of 4 bits (Binary digits).
4. What is Byte?
A collection of 8 bits is called Byte.
5. What is Word Length?
Word length refers to the number of bits processed by a Computer’s CPU.
6. Define ASCII?

The most commonly used coding scheme is the American Standard Code for Information
Interchange. Each binary value between 0 and 127 is used to represent a specific character. The ASCII
value for (blank space) is 32 and the ASCII value of numeric 0 is 48. The range of ASCII values for
lower case alphabets is from 97 to 122 and the range of ASCII values for the upper case alphabets is 65
to 90.

7. List out the Various Memory Sizes?

Name  Abbr. Size

Kilo K 2710 = 1,024

Mega M 2120 = 1,048,576

Giga G 2730 = 1,073,741,824

Tera T 2740 =1,099,511,627,776

Peta P 2A50 = 1,125,899,906,842,624

Exa E 2760 = 1,152,921,504,606,846,976
Zetta Z 2770 = 1,180,591,620,717,411,303,424
Yotta Y 2780 = 1,208,925,819,614,629,174,706,173

8.What is Base Value or Radix?

Number systems are Binary, Octal, Hexadecimal number system. Each number system is uniquely
identified by its base value or radix.
9. What is LSB & MSB?

v" The left most bit in the binary number is called as the Most Significant Bit (MSB) and it has the
largest positional weight.

v' The right most bit is the Least Significant Bit (LSB) and has the smallest positional weight. 4
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10. What are the different types of Number Systems?

Different Types of Number Systems
|

Number Systems
Decimal Binary Octal Hexadecimal
Base value Base value
10 8
(0,1,2,3,4,5,6.7.8,9) Base value (0,1,2,3,45,67)

2

0,1

e Base value

16

(0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F)

11. What is Signed Magnitude?
Computers can handle both positive (unsigned) and negative (signed) numbers. The simplest
method to represent negative binary numbers is called Signed Magnitude.
12. What is Sign bit or Parity bit?
In signed magnitude method, the left most bit is Most Significant Bit (MSB), is called sign bit
or parity bit.
13. What is Binary Arithmetic?
As decimal numbers, the binary numbers also permit computations like addition, subtraction,
multiplication and division.
14. What is BCD?
This encoding system is not in the practice right now. This is 26 bit encoding system.
This can handle 26 = 64 characters only.
15. What is ISCI1?
ISCII is the system of handling the character of Indian local languages. This as a 8-bit coding
system. Therefore it can handle 256 (28) characters
16. What is Unicode?
» This coding system is used in most of the modern computers. The popular coding
scheme after ASCII is Unicode.
» Unicode scheme is denoted by hexadecimal numbers.
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@Part-1II _ Boolean Algebra

1. What are logical Operators?
Boolean algebra makes use of variables and operations (functions). The basic logical operations

are AND, OR and NOT, which are symbolically represented by dot ( . ), plus ( +), and by over bar /
single apostrophe respectively. These symbols are also called as “Logical Operators”.
2. What is Universal Gates?

NAND and NOR gates are called Universal gates, because the fundamental logic gates can be
realized through them.
3. Define XNOR Gate.

The XNOR (exclusive - NOR) gate is a combination XOR gate followed by an inverter. Its
output is "true™ if the inputs are the same, and "false" if the inputs are different. In simple words, the
output is 1 if the input are the same, otherwise the output is 0.

The logic circuit of XNOR gate is

A A~B C=A=~B
B

Logic Circuit of XNOR Gate

The output of the XNOR is NOT of XOR

Jmportant 5 Margs

1. Explain all the fundamental logical gates with an example.
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Logic Gates and their corresponding Truth Tables

Logical Gates Symbol Truth Table
A B AB
B 0 0 0
AND } 0 1 0
— 4 | 0 0
| | |
A B A+B
N SR 0 0 0
OR | — 0 | |
gt | 0 |
| | 1
A | ® |
NOT —{\/‘“C 0 I
L |9
A B AB
— 0 0 |
NAND \‘p p— 0 | 1
vy 1 0 1
1 | 0
A B A+B
0 0 1
NOR :Z>(, 0 | 0
| 0 0
| | 0
A B A@B
& T 0 0 0
XOR ) N 0 | |
— A
7 | 0 1
| | 0
A B | A@B
LN 0 0 1
XNOR __ pesgad— 0 I 0
A | 0 0
| | |
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Chapter-3
COMPUTER ORGANIZATION

Jmportant 2 & 3 Margs

v
v
v
v

CPU.

v

v

1.

2.

3.
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1.
2.
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1. What are the operators carried out by the Instruction Set?

Data transfer
Arithmetic operations
Logical operations
Control flow
Input/output

2. What is MDR?
The Memory Data Register (MDR) keeps the data which is transferred between the Memory and the

3. What is MAR?

The Arithmetic and Logic unit of CPU places the address of the memory to be fetched, into the

Memory Address Register.
4. What is Bus?

A bus is a collection of wires used for communication between the internal components of a

computer.

4. How microprocessor can be classified?

Microprocessors can be classified based on the following criteria:

The width of data that can be processed

The instruction set

5. What are the Microprocessors can be classified based on the data width?

8-bit microprocessor

16-bit microprocessor
32-bit microprocessor

64-bit microprocessor

6. What are the Microprocessors can be classified based on the Instruction Set?

Reduced Instruction Set Computers (RISC)
Complex Instruction Set Computers (CISC)

7. What are Memory Devices?

v Cache Memory
v' Main Memory
v Hard Disk 8
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Jmportant 5 Margs

1. Explain the Basics of Microprocessor.
The microprocessor is made up of 3 main units. They are:
v Arithmetic and Logic unit (ALU): To perform arithmetic and logical instructions based on
computer instructions.
v" Control unit: To control the overall operations of the computer through signals.
v' Registers (Internal Memory): They are used to hold the instruction and data for the execution of

the processor.

Input = Microprocessor ™ Qutput

i

Memory

2. Explain the Basics of Microprocessor.

A Microprocessor’s performance depends on the following characteristics:
a) Clock speed
b) Instruction set

¢) Word size
3. What are the types of RAM?

There are two basic types of RAM
1. Dynamic RAM (DRAM)

2. Static RAM (SRAM)
4. What are the types of ROM?

Read Only Memory (ROM)
Read Only Memory refers to special memory in a computer with pre-recorded data at manufacturing
time which cannot be modified.

1. Programmable Read Only Memory (PROM)

2. Erasable Programmable Read Only Memory (EPROM)

3. Electrically Erasable Programmable Read Only Memory (EEPROM)

9
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5. Explain all the Storage Devices?

1. Hard Disks
2. Compact Disc (CD)
3. Digital Versatile Disc (DVD)
4. Flash Memory Devices
5. Blu-Ray Disc
6. Explain Cache Memory.

The cache memory is a very high speed and expensive memory, which is used to speed up the
memory retrieval process. Due to its higher cost, the CPU comes with a smaller size of cache memory
compared with the size of the main memory. Without cache memory, every time the CPU requests the
data, it has to be fetched from the main memory which will consume more time. The idea of introducing
a cache is that, this extremely fast memory would store data that is frequently accessed and if possible,
the data that is closer to it. This helps to achieve the fast response time, where response Time, (Access
Time) refers to how quickly the memory can respond to a read / write request.

7. Explain Different Types of Ports & Interfaces.

1. Serial Port: To connect the external devices, found in old computers.

2. Parallel Port: To connect the printers, found in old computers.

3.USB Ports: To connect external devices like cameras, scanners, mobile phones, external hard disks
and printers to the computer..

4. VGA Connector: To connect a monitor or any display device like LCD projector.

5. Audio Plugs: To connect sound speakers, microphone and headphones.

6. PS/2 Port: To connect mouse and keyboard to PC. SCSI Port: To connect the hard disk drives and
network connectors.

7. High Definition Multimedia Interface (HDMI): High-Definition Multimedia Interface is an
audio/video interface which transfers the uncompressed video and audio data from a video controller, to

a compatible computer monitor, LCD projector, digital television etc.

10
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Chapter-4
Theoretical concepts of Operating System

Important 2 & 3 Marks

1. What are the types of software?

1. Application Software, Ex: MS Word, VLC

2. System Software, Ex: OS, Language Processor
2. What are the types of Operating Systems?
1. Single User Operating Systems

2. Multi-user Operating Systems

3. What are the levels of Security Mangement?

1. File access level

2. System level
3. Network level

4. Write short note on: FAT

Any type of data in a computer is stored in the form of files and directories / folders through
File Allocation Table (FAT).

5. What is Fault Tolerance?

The Operating Systems should be robust. When there is a fault, the Operating System should
not crash, instead the Operating System have fault tolerance capabilities and retain the existing state of
system.

6. What is Time Sharing?

This is a one of the features of Operating Systems. It allows execution of multiple tasks or
processes concurrently. For each task a fixed time is allocated. This division of time is called Time-
sharing.

7. What are the Prominent Operating Systems?

Prominent OS are as follows:

* UNIX

* Microsoft Windows

e Linux

*i0S

* Android

11
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8. List some of the Proprietary & Open Source Free Licensed Operating Systems.

Operating System

3 3
14 3

« Microsoft windows « UNIX

« Apple Mac OS « LINUX

« Apple iOS [Mobile « Google's Android
Device] [Mobile Device]|

9. List some of the Linux distributors.

m.5 8

BOSS

10. List some of the Android Versions.

Alpha Beta Cupcake Donut  Eclair Froyo Gingerbread

AvvB C o E E.NG

* F 28 TN

Honeycomb o . . JellyBean Kitkat Lollipop Marshmallow Nougat

H I J K L M N

11. Write Short Note on: iOS

iOS (formerly iPhone OS) is a mobile Operating System created and developed by Apple Inc.,
exclusively for its hardware. It is the Operating System that presently powers many of the company's
mobile devices, including the iPhone, iPad and iPod Touch. It is the second most popular mobile
Operating System globally after Android.
12. What is Multiprocessing & Parallel Processing?

It has two or more processors for a single running process (job). Processing takes place in
parallel is known as parallel processing.

12
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Jmportant 5 Marhsg

1. Explain Memory Management.

Memory Management is the process of controlling and coordinating computer’s main memory
and assigning memory block (space) to various running programs to optimize overall computer
performance.

The Operating System is responsible for the following activities in connection with memory
management:

1. Keeping track of which portion of memory are currently being used and who is using them.

2. Determining which processes (or parts of processes) and data to move in and out of memory.

3. Allocation and de-allocation of memory blocks as needed by the program in main memory. (Garbage
Collection)

2. Explain Process Management.

Process management is function that includes creating and deleting processes and providing
mechanisms for processes to communicate and synchronize with each other.

A process is the unit of work (program) in a computer. A word-processing program being run by
an individual user on a computer is a process.

A system task, such as sending output to a printer or screen, can also be called as a Process.
A computer consists of a collection of processes, they are classified as two categories:
* Operating System processes which is executed by system code
« User Processes which is execute by user code

The following algorithms are mainly used to allocate the job (process) to the processor.
1. FIFO
2. SJF
3. Round Robin

4. Based on Priority

13
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3. What is User Interface (Ul)?

User interface is one of the significant feature in Operating System. The only way that user can
make interaction with a computer. If the computer interface is not user-friendly, the user slowly reduces
the computer usage from their normal life. This is the main reason for the key success of GUI
(Graphical User Interface) based Operating System. The GUI is a window based system with a pointing
device to direct 1/O, choose from menus, make selections and a keyboard to enter text.lts vibrant
colours attract the user very easily. Beginners are impressed by the help and pop up window message
boxes. Icons are playing vital role of the particular application.

Now Linux distribution is also available as GUI based Operating System.

The following points are considered when User Interface is designed for an application.
1. The user interface should enable the user to retain this expertise for a longer time.
2. The user interface should also satisfy the customer based on their needs.
3.The wuser interface should save user’s precious time. Create graphical elements like
Menus,Window, Tabs, Icons and reduce typing work will be an added advantage of the Operating
System.
4. The ultimate aim of any product is to satisfy the customer. The User Interface is also to satisfy the
customer.
5. The user interface should reduce number of errors committed by the user with a little practice the
user should be in a position to avoid errors (Error Log File)
4. What is Distributed Operating Systems? Write the Advantages.

This feature takes care of the data and application that are stored and processed on multiple
physical locations across the world over the digital network (internet/intranet). The Distributed
Operating System is used to access shared data and files that reside in any machine around the world.
The user can handle the data from different locations. The users can access as if it is available on their
own computer.

The advantages of distributed Operating System are as follows:

* A user at one location can make use of all the resources available at another location over the
network.

* Many computer resources can be added easily in the network

* Improves the interaction with the customers and clients.

* Reduces the load on the host computer.

14
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Chapter-5
Working with Typical Operating System

Part-I: Working with Windows
Important 2 & 3 Marks

1. What is Operating System? Write the important functions of OS?
An Operating System (OS) is a system software (Figure 5.1) that enables the hardware to
communicate and operate with other software. It also acts as an interface between the user and the

hardware and controls the overall execution of the computer.

| User 1 | | User 2 | Usern

A k4 b

System Application
Softwares Softwares
Software ¢ ¢

| Operating System |

Hardware | CPU || RJ:\M || /O |

2. What are the most popular Operating Systems?

v Windows Series - for desktop and laptop computers.

v Android - for smart phones.

v i0S - for Apple phones, i-Pad and i -Pod.

v" Linux - Open source Operating System for desktop and server.
3. What is Multitasking?

Multiple applications can execute simultaneously in Windows, and this is known as

“Multitasking”.

4. What are the Mouse Actions?
Point to an item

Click

Right click

Double-click

Drag and drop 15

o ~ w0 e
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5. What is Desktop?

6. What is Window?

Title Bar

Menu Bar

The Workspace
Scroll Bars

Corners and Borders
. Task bar

8. What is Task bar?

oA~ whE

9. How will you create the folder?
1. File->New->Folder

2. Right click->New->Folder

computer or in a specific drive.

that displays information for a specific program.

7. What are the elements of a Window?

10. How will you search the files & folders?

The opening screen of Windows is called “Desktop”.

Window is a typical rectangular area in an application or a document. It is an area on the screen

At the bottom of the screen is a horizontal bar called the “Taskbar”’.

You can use the search box on the Start menu to quickly search a particular folder or file in the

11. What is difference between Copying & Moving Folders?

Copying the files & Folder

Moving the files & Folder

1. Click Edit — Copy
Ctrl+C

2. Click Edit — Paste or Ctrl + V.

right click— Copy from the pop-up menu.

3. Right click — Paste from the pop-up menu.

1. Edit — Cut
Ctrl + X
2. Right click — cut from the pop-up menu.

3. Click Edit — Paste from edit menu or Ctrl + V
using keyboard.

4. Right click — Paste from the pop-up menu. The
file will be pasted in the new location.

12. Give Short on Drag & Drop.

left pane.

Mobile: +91- 9677635246

» Click and drag the selected file or folder from the right pane, to the folder list on the

» Release the mouse button when the target folder is highlighted (active).
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13. What is Recycle Bin?
Recycle bin is a special folder to keep the files or folders deleted by the user
14. What is the use of Switch User?

Switch to another user account on the computer without closing your open programs and Windows
processes.
15. Define Hibernate?
Hibernate (found only on laptop computers): Puts the computer into a low-power mode after
saving all running programs and open windows on the machine's hard drive for a quick restart.
16. How will rename folder?
1. File>Rename
2. Right click & Select »Rename from the pop-up menu
3. Select the folder & Press F2 Function key to rename the folder
17. How will you Copy the Files and Folders to removable disk?
There are several methods of transferring files to or from a removable disk.
* Copy and Paste
* Send To
18. How will Log off/ Shut down the Computer?
v" Click start — log off (click the arrow next to Shut down)

v" Start — Shutdown

Jmportant 5 Margs

1. What are various Versions of Windows? (Below the given Keys to keep in mind -Go through
the book to know more)

1. Windows 1.x ,2.X 3.X
2. Windows 95, 98, NT, ME
3. Windows 2000, XP, Vista
4. Windows 7,8,10
17
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Chapter-5

Part - I : Working with Linux (Ubuntu)
Jmportant 2 & 3 Marks

1. What are the Linux Distributors?

1. Ubuntu Linux

2. Linux Mint
3. Arch Linux
4. Deepin

5. Fedora

6. Debian

7. CentOS

2. What are the Significant Features of Ubuntu?

1. The desktop version of Ubuntu supports all normal software like Windows such as Firefox,
Chrome, VLC, etc.

2. It supports the office suite called LibreOffice.

3. Ubuntu has in-built email software called Thunderbird, which gives the user access to email
such as Exchange, Gmail, Hotmail, etc.

4. There are free applications for users to view and edit photos, to manage and share videos.

5. Itiseasy to find content on Ubuntu with the smart searching facility.

3. What are the names of the icons in the Ubuntu OS?
Search your Computer

Files

Firefox Webbrowser

LibreOffice Writer

LibreOfficeCalc

LibreOffice Impress

Ubuntu Software

Amazon

© o N oo o kM w0 D E

System Settings
10. Trash 18
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4. What is use of the Trash?

This icon is the equivalent of Recycle bin of windows OS. All the deleted Files and Folders are moved
here.

5. What is Launcher?
The Launcher (Equivalent to Task bar)

The vertical bar of icons on the left side of the desktop is called the Launcher.
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Chapter-6
Specification and Abstraction

Important 2 & 3 Margs

1. What is Algorithm?
An algorithm is a sequence of instructions to accomplish a task or solve a problem.
2. What are the building blocks of Algorithms?

Data
Variables
Control flow

. Functions
3. What are the Algorithm Design Techniques?

M owbd e

1. Specification

2. Abstraction

3. Composition

4. Decomposition
4. What is Abstraction?

Abstraction is the process of hiding or ignoring the details irrelevant to the task so as to model a
problem only by its essential features.
5. What is State?

In algorithms, the state of a computation is abstracted by a set of variables.
6. What is Functions?

When an algorithm is very complex, we can decompose it into functions and abstract each
function by its specification.

7. What is the use of Assignment Statement?

Variables are named boxes to store values. Assignment statement is used to store a value in a
variable. It is written with the variable on the left side of the assignment operator and a value on the
right side.

Ex: variable :=value
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Chapter-7

Composition and Decomposition

Jmportant 2 & 3 Marks

1. What are the notations for Algorithms?
1. Programming language
2. Pseudo code
3. Flowchart
2. What is Composition?
A statement is a phrase that commands the computer to do an action.
3. What are the Three Important Control Flow Statements?
1. Sequential
2. Alternative
3. Iterative
4. What is Case Analysis?
Alternative statement analyses the problem into two cases.
1. Case analysis statement generalizes it to multiple cases.
2. Case analysis splits the problem into an exhaustive set of disjoint cases.
5. What is Iterative Statement?
Iterative statement repeatedly evaluates a condition and executes a statement as long as the
condition is true.
6. What is Decomposition?
Decomposition breaks down a problem into smaller subproblems and combine their solutions to
solve the original problem.
7. What is Refinement?
After decomposing a problem into smaller subproblems, the next step is either to refine the
subproblem or to abstract the subproblem.
8. What is Functions?
After an algorithmic problem is decomposed into subproblems, we can abstract the
subproblems as functions. A function is like a sub-algorithm. Similar to an algorithm, a function is
specified by the input property, and the desired input-output relation.

inputs
i & Function
algorithm | (S‘%b'
outputs et
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Chapter-8

Tteration and recursion

Jmportant 2 & 3 Marks

1. What is Recursion?

Recursion is another algorithm design technique, closely related to iteration, but more powerful.
Using recursion, we solve a problem with a given input, by solving the same problem with a part of the
input, and constructing a solution to the original problem from the solution to the partial input.

2. What is Iteration?

Iteration repeats the two steps of evaluating a condition and executing a statement, as long as
the condition is true.

3. What is Invariants or Loop Invariant?

There is also a property of the variables which remains unchanged by the execution of the loop
body. This unchanging property is called the loop invariant. Loop invariant is the key to construct and
to reason about iterative algorithms.

4. List the recursive solver cases?

1. Base case: The problem size is small enough to be solved directly. Output the solution.
There must be at least one base case.

2. Recursion step: The problem size is not small enough. Deconstruct the problem into a sub-
problem, strictly smaller in size than the given problem. Call a sub-solver to solve the sub-problem.
Assume that the sub-solver outputs the solution to the sub-problem. Construct the solution to the given

problem.
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